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The search for historical and archaeological artifacts and structures may be 
regulated in different ways from state to state. Searching with a detector may 
require approvals and permissions from landowners, public agencies and/or 
government authorities.
With the purchase of the OKM detector you DO NOT automatically receive a detection 
permit or excavation permit! Consult the authorities responsible for your search 
project and/or area for information on required permits.

NOTICE

The detectors referred to in this guide have been specifically designed and 
manufactured as a high-quality ground scanner and is recommended for treasure 
hunting in non-hazardous environments. These detectors have not been designed 
as mine detectors.
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CHECKLIST: KEY FACTORS

1 ENVIRONMENTAL CONDITIONS
	 	 Know the SOIL TYPE and mineralization.

	 	 Consider MOISTURE and weather conditions.

	 	 Be aware of DISTURBANCES from power lines, vehicles, buildings, etc. 

	 	 Eliminate or maintain distance to OTHER SOURCES OF INTERFERENCE.

2 SCANNING TECHNIQUE
	 	 Ensure correct SCAN DIRECTION.

	 	 Maintain steady walking SPEED.

	 	 Keep consistent PROBE HEIGHT.

	 	 Guarantee equal SCAN LINE SPACING.

	 	 Provide sufficient IMPULSE DENSITY.

3 MAGNETIC INFLUENCES NEAR THE SENSORS
	 	 Remove KEYS and coins from pockets.

	 	 Keep the sensors away from SMARTPHONE and SMARTWATCH.

	 	 Maintain distance to FERROMAGNETIC TOOLS AND ACCESSORIES.

	 	 Avoid METAL ACCESSORIES, such as buckles and jewelry.

	 	 Keep the sensors away from SHOES with metal components, steel-toe work boots.

4 CORRECT MODE SELECTION
	 	 Use OPERATING MODE 3D Ground Scan.

	 	 Select SCAN MODE Parallel (preferred) or Zigzag.

	 	 Choose IMPULSE MODE Automatic or Manual.

1	 INTRODUCTION
Many users ask what their scan images actually show. A successful scan analysis does not only depend on correctly interpreting the scan image, but also on creating a high-quality 
scan image in the first place. Both aspects are closely connected and equally important. 

The purpose of this SCAN ANALYSIS GUIDE is to show you how to 

•	 identify anomalies, 

•	 correctly interpret subsurface structures, 

•	 and avoid misinterpretations. 

A well-performed analysis helps distinguish relevant target signals from soil effects or interferences, and supports informed decisions before excavation.

For an efficient scan analysis that is quick, structured, and reliable, good scan data is essential. For this reason, the first four chapters of this guide – including this Introduction – 
provide an overview of the KEY FACTORS THAT INFLUENCE SCAN QUALITY and explain what is required to produce reliable scans as a foundation for meaningful analysis.

The scan result is influenced by 

1.	 EXTERNAL CONDITIONS such as soil conditions, weather and moisture, but also interferences from power lines, vehicles, buildings, walls, fences, or reinforced concrete.

2.	 TECHNICAL FACTORS are determined by how the scan is performed and include scan consistency as well as software or device settings. 

3.	 MAGNETIC INFLUENCES near the sensors, such as keys, smartphones, tools, or metal accessories, can also distort scan results and must be avoided. 

4.	 The selection of the APPROPRIATE MODES is also crucial: This guide focuses primarily on magnetic field measurement with 3D Ground Scan, as it is the most commonly 
used operating mode for locating buried objects, artifacts and structures. Moreover, different scan modes and impulse modes are designed for different scan field conditions.

The final two chapters focus on practical scan analysis: Chapter 5 presents five simple steps for using Visualizer 3D Studio efficiently to perform a fast and structured scan analysis. 
Chapter 6 explains how to interpret the colors and structures of detected signals in order to evaluate scan results correctly and draw conclusions for further steps.

By understanding the influences and applying the guidelines in this document, users will be equipped to produce high-quality scans and perform reliable scan analyses.
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2	 PREPARATION: CREATING THE RIGHT CONDITIONS FOR RELIABLE SCANS
Successful 3D ground scanning starts long before the first measurement is performed. Careful preparation of the target area and scan field is essential to obtain reliable 
and interpretable results. By defining the target and the scan field, removing obstacles and surface scrap metal, and accounting for environmental influences, you minimize 
interferences and prevent valuable signals from being distorted or masked. A well-prepared scan field improves depth performance, signal clarity, and reproducibility, for 
meaningful scan interpretation and confident target evaluation.

Before conducting any measurements, thorough preparation of the target area is the first step in effective scan analysis. Measuring an area blindly will not produce the expected 
results. The following four steps help you to create the right conditions for good scans:

1 RESEARCH
WHAT are you looking for?  
What material is your target object made of? 

WHAT SIZE do you expect the find to be? 

WHEN has the target object been buried?

WHERE do you think you might find the 
target object?  

Are there historical indications that 
CONFIRM YOUR SUSPICIONS? 

Are the SCAN FIELD CONDITIONS 
favorable?

2 DEFINE
Mark the 4 CORNERS of the scan field.

Determine the scan field DIMENSIONS;  
at least 5×5 m (16×16 ft).

Stake out the area and use ropes to clearly 
DEFINE THE SCAN LINES.

3 REMOVE
Remove OBSTACLES such as high grass, 
bushes, stones, and tree trunks.

Are there SOURCES OF INTERFERENCE 
such as fences, vehicles, walls, power lines, 
etc. in the immediate vicinity?

If obstacles cannot be removed, consider 
using the IMPULSE MODE MANUAL.

 4 CLEAR
Perform a quick scan by using the operating 
mode Magnetometer, Live Sound, Pinpointer 
or Live Scan, if available.

Remove any SMALL FERROUS OBJECTS 
NEAR THE SURFACE from the target area. 
This allows the subsequent 3D Ground Scan 
to deliver more meaningful results.

CHECKLIST: PREPARATION

1 TARGET RESEARCH
	 	 Know your TARGET OBJECT: material, size, shape, depth, time buried.

	 	 Know your TARGET AREA: Review maps and archives, talk to locals.

	 	 Look for CLUES: stone markers, terrain features, vegetation patterns.

	 	 Check SCAN FIELD CONDITIONS: soil type, vegetation, accessibility.

2 FIELD DEMARCATION
	 	 Mark the 4 CORNERS of your scan field.

	 	 Define a scan field of AT LEAST 5×5 m (16×16 ft).

	 	 Know the exact scan field DIMENSIONS.

	 	 Use ropes or strings to DEFINE THE SCAN LINES.

3 OBSTRUCTION REMOVAL
	 	 Remove OBSTACLES like high grass, bushes, stones, tree trunks etc.

	 	 Consider sources of INTERFERENCE such as fences, vehicles etc.

	 	 Consider using the IMPULSE MODE MANUAL in rough terrain.

4 SCRAP METAL CLEARING
	 	 Use Magnetometer, Live Sound, Pinpointer or Live Scan (if available)  

to perform an INITIAL QUICK SCAN of the field.

	 	 Clear the scan field of any FERROUS ITEMS close to the surface.

ADDITIONAL TIPS FOR PREPARATION

 KNOW THE EXPECTED SIZE OF YOUR TARGET OBJECT

If you are looking for large target structures such as tombs, tunnels, or treasure 
chests, you can increase the distance between impulses and scan lines. For small 
objects such as relics, artifacts and jewelry, collect more scan data by reducing the 
distance between impulses and scan lines.

 KNOW THE EXPECTED SHAPE OF YOUR TARGET OBJECT

If you are looking for a sufficient large object, e.g. an aircraft or a bunker, the detected 
signal in your scan field can have a shape according to your expectations.

If you are searching for an elongated object, scan across it (perpendicular) rather than 
parallel to it; otherwise, it may remain hidden between the scan lines. Performing 
control scans rotated by 90° helps ensure that no objects are missed.

 KNOW THE EXPECTED DEPTH OF YOUR TARGET OBJECT

To obtain precise depth values, the object must be positioned in the center of the scan 
image and be surrounded by normal reference values (neutral ground). If the object 
is located at the edge of the scan image and is not fully visible, an accurate statement 
about the depth is not possible.

Ideally, there should only be one object in your scan image. Otherwise, several objects 
in one scan may affect the accuracy of the depth values.

 PLAN SUFFICIENT TIME FOR SCANNING

If conditions in the scan field are not optimal (e.g. rough, sloping terrain and/or dense 
vegetation), using the Impulse Mode Manual can be advantageous. However, this 
requires more time. In addition, to ensure the validity of your scan results, allow time 
for at least two control scans. This will also help you identify mineralized soil.

 PERFORM SCANS OUTDOORS

Always remember that surrounding objects such as fences, walls, reinforcement 
in walls and ceilings, vehicles, power lines, or further sources of interference will 
definitely influence the scan results.
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2.2 DEFINE THE SCAN FIELD
Your first measurement in an unknown area should be sufficiently large to obtain 
representative scan values (e.g. 30 impulses, 10 scan lines). The recommended scan field 
size for reliable scan results is at least 5×5 m (16×16 ft).

Once you have defined your target area, determine your scan field: Use wooden stakes, 
for example, to mark the four corners and note the SCAN FIELD DIMENSIONS. The more 
precisely the length and width are defined, the more accurate conclusions can be drawn 
about the position of potential targets. A clearly staked field also makes it easier to follow the 
scan lines accurately.

Use accessories if needed: If you are not yet experienced, use ropes or chalk to MARK THE 
SCAN LINES to keep them straight. This ensures equal spacing between the scan lines and  
helps to locate hidden target objects inbetween.

2.3 REMOVE OBSTACLES
Walk across the scan field and REMOVE MAJOR OBSTACLES such as tall grass, bushes, 
stones, and tree trunks. These can prevent you from scanning the lines consistently and may 
lead to erroneous scan data. 

If obstacles cannot be removed, consider using Impulse Mode Manual. While it takes more 
time, it allows you to step over obstacles and still record accurate impulses step by step.

Always keep in mind that SOURCES OF INTERFERENCE such as fences, walls, 
reinforcement in walls or ceilings, vehicles, power lines etc. that usually cannot be removed 
will definitely influence your scan results. It is important to consider their effects when 
interpreting the scan data.

2.4 CLEAR THE SCAN FIELD
If you do not yet have a precise idea where to start scanning, it is often useful to perform 
fast scans using the operating mode Magnetometer, Live Sound or Live Scan, if available. 
This provides INITIAL INSIGHTS INTO THE SUBSURFACE, allowing small objects such as 
screws, nails, bottle caps, and other ferrous scrap metal to be located and removed directly. 

Near-surface scrap metal items can generate very strong signals that may mask  
potentially interesting objects located deeper underground. By removing such scrap metal, 
DEPTH PERFORMANCE can be significantly increased, allowing deeper targets to be 
detected more clearly.

2.1 RESEARCH THE TARGET AREA
Research HISTORICALLY RELEVANT LOCATIONS and review maps, online resources, and 
historical archives to better understand the target area. Moreover, speaking with locals, such 
as park rangers, historians, or longtime residents, can provide valuable insights. Visible 
clues such as old markers, unusual terrain features, or distinct vegetation patterns may also 
indicate potential targets. 

Before scanning, evaluate the FIELD CONDITIONS, including soil type, mineralization, 
vegetation, and accessibility, to ensure reliable scan data recording. Clearly define your 
target by determining what you are looking for, the material and expected size of the object 
and how long it has been buried. Supporting your assumptions with historical evidence will 
further improve the reliability of your 3D Ground Scans.
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~10 cm | 4"

3	 MEASUREMENT: PERFORMING SCANS WITH TECHNIQUE
During the measurement, the detector operator plays a decisive role in achieving good results. Two factors are particularly important: PROBE HANDLING and WALKING 
TECHNIQUE. By applying these tips consistently and with some practice, scans become highly repeatable, making signal verification significantly easier.

High measurement accuracy is essential for achieving high-resolution scan images, as consistent scan direction, spacing, speed, and impulse density directly determine the level 
of detail and reliability of the results.

1 DIRECTION
The direction of the probe refers to  
WHERE THE PROBE IS POINTING. 

The first scan line defines the direction for 
the entire scan.

All scan lines must be scanned PARALLEL 
TO EACH OTHER. Thus, always keep the 
probe pointing in the SAME DIRECTION. 
This also applies to Scan Mode Zigzag.

If available, use the ARROW on top of the 
probe as a reference.

DO NOT TURN OR ROTATE the probe 
during scanning.

2 ORIENTATION
The orientation of the probe refers to 
HOW THE PROBE IS HELD.

Always keep the probe STRAIGHT and 
upright during the measurement.  
DO NOT PIVOT OR TILT the probe.

Do not grip the vertical probe tightly to force 
it into a diagonal position while scanning. 
HOLD IT LOOSELY at the top and let gravity 
keep the probe vertical.

CORRECT HANDLING of the probe ensures 
clear scan images and reliable results.

3 DISTANCE
Keep the probe at the same HEIGHT during 
the measurement.

RECOMMENDED DISTANCE TO THE 
GROUND: 5–10 cm | 2–4" (use the height of 
the foot arch as a reference).

Do not scan too close to your SHOES.

If the scan field contains WIDESPREAD 
OBSTACLES such as dense vegetation that 
cannot be cleared, raise the probe slightly 
and maintain this distance to the ground 
consistently throughout the entire scan.

CONSISTENT HEIGHT ensures reliable 
scan results.

4 ACCURACY
Maintain CONSISTENT SPACING between 
scan lines to ensure full coverage and avoid 
gaps or overlaps in the scan field.

Move at a STEADY AND EVEN PACE during 
the scan; changes in speed can distort the 
scan data.

Follow the PREDEFINED SCAN GRID 
accurately to preserve resolution and make 
interpretation easier.

Avoid abrupt movements, stops, or direction 
changes, as SMOOTH SCANNING ensures 
uniform data collection.

Consider using the IMPULSE MODE 
MANUAL in rough or uneven terrain to 
maintain control and accuracy.

CHECKLIST: MEASUREMENT

1 PROBE DIRECTION
	 	 The FIRST SCAN LINE defines the probe direction for the entire scan.

	 	 All scan lines must be PARALLEL TO EACH OTHER.

	 	 Keep the probe pointing in the SAME DIRECTION.

	 	 Use the ARROW on top of the probe as a reference.

	 	 DO NOT TURN OR ROTATE the probe.

2 PROBE ORIENTATION
	 	 Keep the probe STRAIGHT during scanning.

	 	 DO NOT PIVOT OR TILT the probe.

	 	 DO NOT FORCE the probe into a diagonal position.

3 DISTANCE TO THE GROUND
	 	 Keep the probe at a CONSTANT HEIGHT throughout the scan.

	 	 Recommended distance to the ground: 5–10 cm | 2–4".

	 	 Do not scan too close to your FOOTWEAR.

	 	 If widespread obstacles cannot be removed, 	
		  increase the height for the ENTIRE SCAN.

4 ACCURACY OF THE MEASUREMENT
	 	 Keep EQUAL SPACING between scan lines.

	 	 Scan at a STEADY PACE.

	 	 Follow the SCAN GRID precisely.

	 	 SMOOTH SCANNING: Avoid sudden stops or abrupt movements.

	 	 Consider using the IMPULSE MODE MANUAL in rough terrain.

ADDITIONAL TIPS FOR SCANNING

 ALIGN SCAN LINES IN NORTH–SOUTH DIRECTION

Experience shows that scans performed in a north–south or south–north direction 
often produce clearer results. If possible, align the scan lines with the Earth’s natural 
magnetic field by walking parallel to the meridians. 

This does not apply to 90° rotated or diagonal control scans as well as to elongated 
objects aligned parallel to the scan lines. Especially in the latter case, performing a 
scan perpendicular to the object is highly recommended.

 MAINTAIN A SLOW AND STEADY SCANNING PACE

Walk slowly and evenly along each scan line to collect a sufficient number of impulses 
(measuring points). A higher number of impulses results in a more detailed scan 
image, making it easier to detect smaller or deeply buried objects.

 INCREASE SCAN LINE DENSITY AND IMPULSE COUNT

Increasing the number of scan lines and reducing the distance between impulses 
improves data density. The more impulses are collected, the higher the image 
resolution and the better the chance of identifying subtle or hidden anomalies.

 KEEP EQUAL DISTANCE BETWEEN SCAN LINES

Keep the distance between scan lines consistent throughout the scan. Uniform spacing 
ensures an accurate scan image, as the software Visualizer 3D Studio displays the 
imported scan data at evenly spaced intervals. Inconsistent spacing can therefore lead 
to distortions in the scan image.

In addition, equal and reduced distances help prevent interpretation errors and missed 
targets between the lines.

 MAINTAIN A CONSTANT SPEED IN ALL SCAN LINES

Try to walk all scan lines at the same speed to achieve reliable and comparable 
results. If uneven terrain or obstacles make a constant pace difficult, switching from 
Impulse Mode Automatic to Manual can help maintain scan accuracy.
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3.1 KEEP THE PROBE DIRECTION CONSISTENT
The direction of the probe – meaning WHERE THE PROBE IS POINTING – is a critical 
factor during the scan process. All lines must be scanned in straight lines without curves 
and parallel to each other, whereas the first scan line defines the reference direction. All 
following scan lines must maintain the same direction and be spaced at regular, consistent 
intervals. This rule also applies when using Scan Mode Zigzag. The arrow on top of the 
probe (if available) helps you to point in the defined scan direction throughout the entire 
measurement.

DO NOT ROTATE THE PROBE WHILE SCANNING. This applies to all scan modes based 
on magnetic field measurement – such as 3D Ground Scan, Magnetometer or Live Sound, 
Pinpointer, Tunnel Scan, and Live Scan. If the probe is rotated during the measurement or 
points in the wrong direction, false signals or even striped scan images can occur –  
see 6.5.4 Vertically Striped on page 43.

3.2 KEEP THE PROBE ORIENTATION STRAIGHT
The orientation of the probe – meaning HOW THE PROBE IS HELD – is crucial for accurate 
and reliable scan results. During the scan, always hold the vertical probe straight and 
upright, and the horizontal probe well balanced and perfectly level.

DO NOT PIVOT OR TILT THE PROBE.

Avoid holding the probe diagonally, tilting it forward or backward. Avoid gripping it tightly or 
forcing the probe into a particular angle while walking. Rather hold the probe gently at the top 
and allow gravity to naturally keep it vertical. 

Maintaining the correct probe orientation ensures that the sensors receive a consistent 
signal. Improper handling of the probe can produce false signals, meaning the scan may 
indicate an anomaly where there is actually no target. Thus, focus on smooth, straight 
movement, keeping the probe stable throughout the measurement process.

3.3 MAINTAIN A CONSTANT PROBE HEIGHT
Maintaining a CONSISTENT DISTANCE between the probe and the ground is essential for 
accurate scan results. Keep the probe at the same height as at the starting point.

The RECOMMENDED DISTANCE TO THE GROUND IS 5–10 cm (2–4"), which is roughly 
equivalent to the height of the foot arch – a convenient reference for consistent positioning. 
However, avoid detecting your footwear or use shoes without metallic appliances.

If the scan field contains widespread obstacles such as dense vegetation, crop stubble, or 
bushes that cannot be cleared, raise the probe slightly and maintain this height consistently 
throughout the entire scan. For isolated obstacles such as tree trunks or rocks, split the scan 
field or use Impulse Mode Manual. TAKE NOTES OF SUCH IRREGULARITIES and in which 
scan line they occur, as these information may be relevant for later analysis. 

Varying the distance to the ground, for example by repeatedly bouncing while walking, can 
distort the scan images and affect the accuracy of the results.

3.4 ENSURE HIGH SCAN ACCURACY
Scan accuracy is essential for achieving HIGH-RESOLUTION SCAN IMAGES, as consistent 
line spacing, speed, and impulse density directly determine the level of detail and reliability.

The distance between scan lines and impulses should be consistent to avoid gaps or 
overlaps. SMALLER DISTANCE BETWEEN IMPULSES – ideally 15 to 20 cm (6 to 8") – further 
increases the precision of the scan image: The more impulses are recorded, the more 
detailed the scan image and the smaller the detectable objects.

In addition, a smooth, continuous, and CONSTANT PACE ensures that the sensors collect 
data evenly. By carefully controlling both the impulse density and the walking speed, you can 
achieve scan images that are both accurate and easy to interpret. 

Poor accuracy in measurement – such as inconsistent spacing or uneven walking – can result 
in distorted images, misleading signals, or missed targets. Using the Impulse Mode Manual 
may help you achieve high-resolution scans even in rough terrain.
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4	 FOLLOW-UP: REVIEWING AND VERIFYING SCAN RESULTS
Perform control scans and document important details related to the measurement. Depending on the detector model and available storage capacity, control scans can be carried 
out before transferring the data to a notebook with Visualizer 3D Studio.

With some detectors, such as the Rover C4, storage capacity is limited. In these cases, up to four scans belonging to the same scan field can be transferred together and organized 
as a complete scan series or project before proceeding with the measurements on the next scan field.

1 REPEAT
Perform at least 2 CONTROL SCANS  
on the same scan field.

Repeat a Control Scan from the same 
starting point and in the SAME DIRECTION 
as the original scan.

Perform another Control Scan from the 
side, ROTATED BY 90°.

Note: REAL TARGETS DON'T MOVE – 
shifting anomalies usually indicate soil 
mineralization or other interferences.

2 SPECIFY
TAKE NOTES on the measurement and the 
scan field for later reference.

Record SOIL CONDITIONS, weather, and 
SURROUNDINGS (walls, fences, power 
lines).

RECORD SPECIAL SITUATIONS that 
occurred during the scan (stepping over 
obstacles, avoiding objects, stumbling), and 
note where they occurred (scan line).

You may add PHOTOS of the scan field.

Use clear project names and ORGANIZE 
YOUR SCAN DATA.

3 ADJUST
Take a first look at your scan images: Check 
whether anomalies appear near the edges 
of the scan field.

CENTER THE AREA OF INTEREST  
by moving the scan field.

Adjust the field to identify the boundaries of 
a target.

SIGNALS WITHOUT A CLEAR STRUCTURE 
usually indicate soil mineralization, not 
relevant targets.

4 CONSIDER
Use IMPULSE MODE MANUAL when 
obstacles, dense vegetation, or sloping 
terrain prevent a steady walking pace.

TRIGGER IMPULSES MANUALLY by 
pressing the button on the probe/Control 
Unit.

CHECKLIST: FOLLOW-UP

1 CONTROL SCANS
	 	 Perform at least 2 CONTROL SCANS.

	 	 Repeat the initial scan under IDENTICAL conditions.

	 	 Perform another scan from the side, ROTATED BY 90°.

	 	 Note: REAL TARGETS DON'T MOVE.

2 SCAN DOCUMENTATION
	 	 TAKE NOTES for later reference.

	 	 Document SOIL AND WEATHER CONDITIONS 
		  (mineralization, moisture, soil composition).

	 	 Document ENVIRONMENTAL FACTORS 
		  (vegetation, obstacles, nearby structures).

	 	 Document SPECIAL SITUATIONS occurring during the scan  
		  and note where they occurred (scan line).

3 SCAN FIELD ADJUSTMENT
	 	 Do signals appear NEAR THE EDGES? Center the area of interest.

	 	 Capture the BOUNDARIES OF TARGET STRUCTURES.

	 	 SCATTERED SIGNALS usually do not indicate relevant targets.

4 CONSIDERATION OF MANUAL MODE
	 	 Do OBSTACLES OR DENSE VEGETATION prevent you from a  
		  steady scanning pace?

	 	 Does SLOPING OR DIFFICULT TERRAIN prevent you from a 	
		  steady scanning pace?

ADDITIONAL TIPS FOR FOLLOW-UP

 REVIEW SCAN DATA ON SITE AND ADJUST IMMEDIATELY

Check the scan image briefly during or between scans to adjust the scan field on site in 
real time, if necessary. This allows you to perform additional useful scans immediately, 
especially if returning to the scan location at a later time would be difficult or delayed.

 ADD PHOTOS OF THE SCAN FIELD

Take photos clearly showing the scan area and its surroundings. These images help 
document ground conditions, obstacles, and the exact scan location, supporting later 
evaluation and comparison.

 ADD GPS LOCATION INFORMATION

Whenever possible, record GPS coordinates of the scan field. This helps precisely 
relocate the scan field, supports documentation, and ensures accurate reference for 
future scans or follow-up investigations.

 USE UNIQUE PROJECT NAMES AND ORGANIZE SCAN DATA
Assign clear and unique project names and keep all scan data well organized. 
Structured data management makes it easier to find, compare, and interpret scans at 
a later stage, especially when working on multiple projects or returning to a site after 
some time.
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4.1 REPEAT YOUR SCAN
Perform at least two CONTROL SCANS to verify and confirm your scan results. Repeating 
the scan on the same field is essential, as the first scan is rarely perfect.

Control scans (images 2 and 3) should be performed from the same starting point and in 
the same direction as the original scan (image 1). This helps to check the consistency and 
REPEATABILITY of the measurement.

A further control scan (image 4) should be performed from the side, rotated by 90° relative 
to the original scan. This additional perspective helps to VALIDATE THE POSITION AND 
STRUCTURE of detected anomalies. Moreover, it helps detect elongated objects that might 
otherwise remain hidden between the scan lines.

Note: REAL TARGETS DO NOT MOVE. If an anomaly changes its position in the control scans, 
it is most likely caused by soil mineralization or other interferences rather  
than a real object.

4.2 SPECIFY SCAN CONDITIONS
Any special conditions or irregularities that occur during the scan should be noted, as they 
can directly influence the scan image and help explain unusual signal structures.

It is recommended to take photos of the scan field in order to document the original ground 
conditions. In addition, notes on SOIL CONDITIONS – including mineralization and soil 
composition – as well as WEATHER CONDITIONS and surrounding ENVIRONMENTAL 
FACTORS like vegetation, obstacles, or nearby structures can be highly relevant.

SPECIAL SITUATIONS during the scan should be documented as well. These include 
stepping over or around obstacles, temporarily lifting the probe, or stumbling during the 
measurement. It is particularly important to note where these events occurred, for example 
the affected scan line or position within the scan field. We recommend to repeat the scan and 
improve your scanning technique. 

Clear project naming and well-organized scan data further ensure that measurements can 
be easily reviewed, compared, and interpreted at a later stage.

4.3 ADJUST THE SCAN FIELD POSITION
Even if all scanning instructions are followed correctly, it may happen that the central area 
of the scan field shows little or NO ANOMALIES, while more interesting SIGNALS APPEAR 
NEAR THE EDGES (images 2a and 2b).

In other situations, a large number of SCATTERED SIGNALS in all colors may be visible 
across the entire scan image, appearing without a recognizable structure (image 1). Such 
scan images typically indicate soil mineralization rather than distinct target signals.

In both cases, the scan field should be moved: REPOSITION THE SCAN FIELD so that the 
area of interest is located in the center of the scan (image 3). This improves image clarity and 
makes interpretation easier. 

Adjusting the scan field can also help to better IDENTIFY THE BOUNDARIES AND SHAPE  
of the target object, leading to more reliable and detailed scan results.

4.4 CONSIDER MANUAL IMPULSE MODE
Impulse Mode Manual can be especially useful when the scan field contains larger obstacles 
or DIFFICULT, UNEVEN OR SLOPED TERRAIN CONDITIONS. If you need to climb over 
tree trunks, wall foundations, or if rocky ground, slippery surfaces, or dense undergrowth 
prevents you from walking at a consistent speed, switching to Impulse Mode Manual can 
improve measurement quality.

In Impulse Mode Manual, impulses are not recorded automatically at the preset intervall. 
Instead, a scan value is only collected when you press the button on the probe or Control 
Unit. This gives you FULL CONTROL OVER WHEN SCAN VALUES ARE RECORDED and helps 
you keep similar distances between impulses, resulting in a more even scan grid and more 
reliable scan images.

1 2a

2b 3

1 2

3 4
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5	 FIRST STEPS IN VISUALIZER 3D: PREPARING AND ENHANCING SCAN DATA
This chapter focuses on understanding the basics after transferring the scan files. It introduces the five most important steps for a fast and easy scan analysis using the proprietary 
software Visualizer 3D Studio. How to transfer scan files from your detector is explained in the corresponding manual.

CHECKLIST: 5 STEPS IN VISUALIZER 3D STUDIO

1 CHARACTERISTICS
	 	 Add a PROJECT TITLE.

	 	 Enter FIELD LENGTH and FIELD WIDTH.

	 	 Check the SCAN MODE.

	 	 Add DETAILS about irregularities, environment etc.

2 TOP VIEW
	 	 Toggle between VIEWS.

	 	 Select TOP VIEW.

3 TARGET FOCUS
	 	 Adjust the THRESHOLD.

	 	 Toggle between COLOR SCHEMES.

	 	 Use WIREFRAME view.

4 SOIL TYPE
	 	 Select a SOIL TYPE.

	 	 Define INDIVIDUAL SOIL TYPES, if neccessary.

5 SCAN INFORMATION
	 	 Place the CROSSHAIRS on prominent signals.

	 	 Determine the DEPTH and POSITION.

	 	 Read and compare SCAN VALUES.

1 MAIN TOOLBAR: CHARACTERISTICS
also accessible via Main Menu > Edit  
or keyboard shortcut F9

2 LEFT SIDEBAR: TOP VIEW
also accessible via Main Menu > View  
or keyboard shortcut F6

3 RIGHT SIDEBAR: VISUALIZATION
also accessible via Main Menu > View > Sidebars

4 RIGHT SIDEBAR: SOIL TYPES
also accessible via Main Menu > View > Sidebars

5 RIGHT SIDEBAR: SCAN INFORMATION
also accessible via Main Menu > View > Sidebars

1

2
3

5
4
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5.1 ADD SCAN DETAILS

Open Characteristics to add further scan details. This window can be opened via

•	 Icon  in the main toolbar

•	 Keyboard shortcut F9

•	 Main Menu > Edit > Characterisctics.

The Characteristics window allows to add or adjust scan details in the General tab:

•	 FIELD LENGTH and FIELD WIDTH. 

•	 SCAN MODE: Parallel or Zigzag.

•	 Project Title.

•	 Notes about the scan characteristics, details about the scan field, terrain, 
conditions, and weather, or special incidents during the scan process.

•	 GPS Location to remember the location of your scan field.

In the other 3 tabs, users can add a Scan Field Overlay, select a Soil Type, or get more 
Meta Data. For more details, please refer to the Software Documentation.

The SCAN FIELD DIMENSIONS play a key role in locating a target within the scan area. 
The more accurately the length and width are defined, the more reliably the position 
and size of potential targets can be determined. The units can be switched between 
metric (m) and imperial (ft) via Main Menu > Extras > Preferences > Measurement 
System.

Information about the SCAN MODE used can be helpful during scan evaluation. In 
Characteristics, this information is displayed for reference only. Changing this option 
does not affect the graphical representation of your scan result.

5.1.1 SCAN FIELD DIMENSIONS
The scan field dimensions are essential for 
accurately locating the target object within the 
scan field. 

The more precisely the length and width are 
defined, the more accurate the conclusions about 
the position and size of potential targets.

The FIELD LENGTH corresponds to the length of the scan lines and is directly related 
to the number of impulses recorded. It is either set before starting the scan or, when 
using Auto mode, at the end of the first scan line.

The FIELD WIDTH is related to the number of scan lines and corresponds to the total 
distance between the first and the last scan line.

The assigned field length and field width are also displayed in the status bar at the 
bottom of the graphical user interface.

5.1.2 SCAN MODE
In Visualizer 3D Studio, the Scan Mode is displayed 
for reference only. With newer detectors, this 
information is transferred automatically. If it is 
missing, you can enter it here in Characteristics.

With detectors such as the Rover C4, the correct 
scan mode must be selected during the file 
transfer. If in doubt, transfer the scan file with the 
correct information again. For more details please 
refer to the respective manual.

Even though the Scan Mode Zigzag can save time, especially on large scan fields, we 
always recommend using the Scan Mode Parallel. Parallel mode allows to collect scan 
data in higher quality, as scanning can be performed more consistently in terms of 
walking speed and alignment of the scan lines.

Information about the scan mode can be helpful during scan evaluation: For example, 
vertically striped scan images may indicate that

•	 the scan was performed in Zigzag scan mode, but the probe was rotated in every 
other scan line – see 6.5.4 Vertically Striped on page 43, or

•	 the Scan Mode was set to Parallel, but the scan field was traversed in zigzag 
manner – see Reference: Rotational Tests with OKM Rover C4 on page 52.

In both cases, the probe pointed at least once in the wrong direction.

For proper scanning techniques, please refer to the respective manual and/or 
the OKM 3D GROUND SCAN GUIDE – see 7	 Related Resources on page 44.

5 4 3 2 1

3D Ground Scan
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Probe Direction
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https://service.okmdetectors.com/r/g-sa-v3ds-documentation
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5.2 SELECT TOP VIEW

Toggle between the different preset views to rotate the current scan image. For fast 
and easy scan evaluation, we recommend Top View. This is accessible via

•	 Icon  in the left sidebar

•	 Keyboard shortcut F6

•	 Main Menu > View > Top View.

5.2.1 ADVANTAGES OF TOP VIEW
The top view allows you to

•	 gain a better ORIENTATION in your scan field: The starting point is located in the 
bottom right corner.

•	 see the AXES more clearly: The red axis represents the impulses along a scan 
line, while the green axis represents the scan lines next to each other.

•	 see the signals in the scan field in the correct SPATIAL PROPORTIONS  
and thus determine their position more accurately.

•	 move and set the CROSSHAIRS more easily –  
see 5.5.1 Placing the Crosshairs on page 28.

5.2.2 FURTHER VIEWS
In addition to the Top View, three further PRESET VIEWS are available:  
Perspective View, Side View, and Front View. These are predefined rotations of the same 
scan image, allowing the scan result to be examined from different angles.

The viewing angle can also be adjusted individually using the mouse when ROTATE 
mode  in the left sidebar is activated.

To display various perspectives simultaneously – as shown in the screenshot above – 
select the desired VIEWPORT  (Default) or  (Quad) in the main toolbar. For more 
details, please refer to the Software Documentation.

PERSPECTIVE VIEW provides a three-dimensional representation of the scan image 
and is especially useful for an initial assessment of potential targets. 

The spatial visualization allows 
you to recap the scan by viewing 
signal position and signal 
strength at the same time.

If Flat Surface and Depth Plane 
are activated in the Visualization 
panel (right sidebar), the 
Perspective View allows you to 
SEE SIMULTANEOUSLY:

WHERE the signal is located in 
the scan field and

HOW STRONG the signal is.

SIDE VIEW AND FRONT VIEW are helpful for IDENTIFYING SIGNAL AMPLITUDES 
more easily. Side View always displays the scan from the right-hand side. To switch 
to the left-hand side, use Ctrl  + . Front View always displays the scan from the 
starting point in the scan direction. Press Ctrl  +  to switch to rear view.

If multiple signals are located 
close to each other, view the 
scan from all four directions to 
distinguish individual signals:

Open Transformations in the 
right sidebar, go to Rotation, and 
rotate the scan around the blue 
axis with . An angle of 90° 
is preset, but can be adjusted 
individually.

This allows you to examine the 
scan from different angles and 
improves the reliability of the 
signal interpretation.

Top View

Perspective View

Side View

Front View
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5.3 FOCUS ON TARGET SIGNALS

Optimize the scan image to focus on the most prominent signals. To do this, adjust its 
Visualization such as Threshold and Color Scheme. These options can be adjusted in the 
control panel accessible via:

•	 Icon  in the right sidebar

•	 Main Menu > View > Sidebars > Visualization.

5.3.1 ADJUST THE THRESHOLD
Use the buttons  to increase or  to reduce the Threshold gradually.

Increasing the threshold brings 
more anomalies into view within the 
scan image. This can be helpful for 
IDENTIFYING WEAKER SIGNALS or 
previously hidden anomalies that may be 
masked by stronger signals.

Reducing the threshold allows you to 
DE-EMPHASIZE MINOR SIGNALS and 
helps focus on the core structure of 
larger, dominant anomalies. This makes 
the main targets clearer and easier to 
evaluate.

OKM DETECTORS

5.3.2 TOGGLE BETWEEN COLOR SCHEMES
Toggling between the preset Color Schemes helps you recognize detected signals more 
clearly: By varying the color settings, subtle or partially hidden signals can be made 
more visible, allowing weak anomalies to stand out more clearly from the background.

Select your preferred color scheme from the list to display the scan 
image in different colors. Depending on the color scheme selected, 
certain anomalies and details may become visible.

5.3.3 COLOR INTERPRETATION
The scan values are processed relative to each other in the 
software. As a result, every scan image always contains at 
least one red, green and blue (RGB) signal: The maximum value 
is displayed as red signal, while the minimum value is shown 
in blue. For correct interpretation, the next important step is to 
evaluate the signal strength (amplitude) – see 6.4 Assess Scan 
Value Strength on page 38.

Applying various color schemes allows a more flexible 
interpretation of scan data: It helps you move away from fixed 
assumptions about the meaning of green, red, and blue signal 
structures in scan images.

Depending on soil conditions and scan parameters, the color distribution in scan 
images can shift significantly. In such cases, relying on the widespread but misleading 
interpretation that red indicates a treasure and blue indicates a void is not 
appropriate.

3

Original Scan Scan with adjusted 
Threshold

Scan with switched 
color scheme

Original Scan Scan with adjusted 
Threshold

Scan with switched 
color scheme
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5.4.1 SOIL TYPE PARAMETERS
The predefined soil types are based on specific parameters which are also required 
when creating custom soil types. These parameters influence the depth determination 
as follows:

DIELECTRIC CONSTANT is a measure of the conductivity 
of electric fields. The higher the value, the lower the depth 
penetration. This is particularly relevant for scans with the 
Ground Penetrating Radar (GPR).

PERMEABILITY is the measure of the conductivity of magnetic 
fields. The higher the value, the lower the depth penetration.

MINERALIZATION defines the metal content of the soil.  
Higher mineralization reduces the detection depth.

Higher HUMIDITY values of the soil reduce the depth 
performance of GPR, but do not affect 3D Ground Scans.

HOMOGENEITY defines the compactness of the soil.  
Higher homogeneity increases the detection depth.

The parameters of the predefined soil types are displayed as tooltip when hovering the 
mouse over the individual soil types. Moreover, the parameters of the selected soil type 
are provided in the PDF Report 1 under Soil Type Information. 

PDF Report1 is accessible via 

•	 Icon  in the main toolbar, 

•	 Keyboard shortcut  Ctrl  + P , or 

•	 Main Menu > File > Export > PDF Report.

5.4.2 ADVANTAGES OF CUSTOM SOIL TYPES
Soil profiles are often composed of multiple layers with different properties. Thus, 
experienced users who have detailed knowledge of the local soil conditions may also 
create User Defined Soil Types1.

The visible surface layer does not necessarily represent the 
actual subsurface soil structure. If the soil composition is 
unknown, select the soil type that is

•	 typical for the region, 

•	 most predominant at the site, 

or create a custom soil type based on average values derived 	
from the actual soil composition.

Defining custom soil types 

•	 allows depth estimations to be adapted more precisely to local ground conditions, 
going beyond the global average soil types provided in the software,

•	 allows a more reliable interpretation of depth-related structures in complex or 
layered soil conditions,

•	 improves consistency across repeated scans in the same area, and

•	 increases the comparability of scan results over time.

5.4 SELECT A SOIL TYPE

Select the Soil Type that best matches your scan field from the list via:

•	 Icon  in the right sidebar

•	 Main Menu > View > Sidebars > Soil Types

•	 Main Menu > Edit > Characteristics > Soil Type (third tab).

The available soil classifications in Visualizer 3D Studio comprise:

•	 OKM Standard Soil Types, 

•	 USDA Soil Classification1, 

•	 OKM GPR Soil Types1,

•	 User Defined Soil Types1.

The predefined soil types in Visualizer 3D Studio represent general average soil 
conditions worldwide. For more precise depth measurements, we recommend defining 
individual soil types1. 

The more closely the selected soil type matches the actual conditions of your scan 
area, the more accurate the depth estimation will be. 

Selecting the correct soil type directly influences the depth determination – see 5.4.1 
Soil Type Parameters on page 27.

Moreover, take into consideration that the visible surface layer does not always 
correspond to the actual soil profile. Soils are often composed of different layers. If you 
are not sure, choose a soil type that is typical for the region or most prevalent at your 
site. If you are unsure which soil type to select, Standard can be used, as it represents 
the average of all OKM Standard Soil Types.

Alternatively, read the depth values at significant scan points while toggling between 
soil types and derive an average value.

1 only available in Professional Edition

4
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5.5.2 MEASURING VALUES VS. SCAN VALUE
First, both measurement point and scan point are used synonymously to refer to an 
IMPULSE. In contrast, measuring values and scan values have different meanings:

The MEASURING VALUES refer to the 
individual IMPULSES, meaning specific 
measurement points at which the sensors 
record data. These are defined by the 
number of scan lines multiplied by the 
number of impulses per scan line:

The example shown on the left comprises 28 
scan lines with 128 impulses each, resulting 
in a total of 3,584 measuring values.

The SCAN VALUE is the actual value 
detected by the sensor at that specific 
impulse (measurement point) after 
modification – if filters were applied. This 
value indicates the signal strength. This 
becomes particularly clear in the Side View 
– see 5.2.2 Further Views on page 23: 

The stronger the amplitudes of the scan 
values, the more significant the anomaly.

All values are processed relatively to 
each other and visualized as color-coded 
amplitudes – always represented by 
red and blue signals – see 5.3.3 Color 
Interpretation on page 25. These provide 
indications about the depth and kind of 
buried objects and structures.

5.5.3 DETERMINING THE DEPTH
If a combined red-blue signal is detected, indicating the potential presence of a 
ferromagnetic object – see 6.3 Interpret Colors and Structures on page 36 –, place 
the crosshairs between the two signals as shown in the example below. Based on our 
experience, this method has repeatedly provided fairly RELIABLE DEPTH ESTIMATES:

The scan field is 
relatively small, but a 
very high number of 
impulses were recorded. 
As a result, the strong 
red and blue signals 
each extend over several 
impulses and, hence, 
indicate a target object.

As an alternative approach, an AVERAGE DEPTH can be calculated from the depth 
values at the most prominent signals. When using this method, note that very strong 
signals can lead to MISLEADING CONCLUSIONS about the depth. In particular, signals 
that are very strong in amplitude (scan value) but are very small in size (number of 
impulses) tend to produce less reliable depth indications. Based on experience, such 
very small signals (in terms of number of impulses they span) represent small near-
surface items or interferences rather than deeper, clearly defined targets.

The scan field size 
is adequate, but the 
number of impulses is 
low. The wireframe view 
reveals that the strong 
signals comprise only 
one impulse each, but 
show a strong depth. This 
indicates a false signal.

The larger the signal (in terms of spatial extent – meaning the number of impulses it 
spans), the more significant the anomaly and the more reliable the depth estimation.

The indicated depth is an estimate, as it depends on various factors such as soil 
structure and soil composition. During excavation, the target object may therefore be 
encountered at a shallower depth than indicated – which can be advantageous and 
reduce further digging – or it may be located deeper than expected. Excavation 
should continue until the object is found, provided the signal has been verified 
as reliable – see 6.2 Identify Real vs. False Targets on page 34.

5.5 ACCESS SCAN INFORMATION

The scan data at the crosshairs position is provided under Scan Information. Open the 
panel via 

•	 Icon  in the right sidebar

•	 Main Menu > View > Sidebars > Scan Information.

In addition, a summary is provided in the status bar below the scan image: 

The status bar is especially useful when comparing depth estimates across different 
soil types: Cycle through the soil types and read the corresponding depth values 
simultaneously in the status bar. This way, there is no need to switch back and forth 
between the Scan Information and Soil Types panels.

5.5.1 PLACING THE CROSSHAIRS
Select the most prominent signals in the scan image to view the corresponding scan 
values under the Crosshairs. To do this

•	 use the arrow keys ←  →  ↑  ↓  on the keyboard 

•	 or activate Selection Mode ("Pick") via  in the left sidebar. 

Place the crosshairs at the desired measurement point by moving it with the arrow 
keys on the keyboard. Alternatively, move the mouse pointer to the desired spot and 
click into the scan image with the left mouse button (LMB).

This is most efficiently done in Top View – see 5.2.1 Advantages of Top View on page 22 –, 
as it provides a clear, plan-view representation of the scan field.

In this example, the crosshairs are 
positioned at the following location within 
the scan field: Impulse 56 (out of 128)  
in Scan Line 16 (out of a total of 28).

In addition, especially when Wireframe is 
enabled (via Right Sidebar > Visualization > 
Scan Image), it becomes clear that both the 
red and the blue signals consist of multiple 
impulses (measuring points).

Pease note: The crosshairs can only be placed on measuring points, not between 
them. A higher number of impulses increases scan resolution and provides greater 
flexibility and precision when positioning the crosshairs.

If you cannot see the crosshairs (white lines), check that the Crosshairs Opacity slider 
via Right Sidebar > Visualization > Elements is not set to zero (left).
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CHECKLIST: EVALUATION

1 CONTROL SCAN COMPARISON
	 	 Arrange WINDOWS SIDE BY SIDE.

	 	 ROTATE THE SCAN IMAGE if you scanned from a 90° angle.

	 	 Look for REPEATABLE SIGNALS at the same positions.

2 MINERALIZATION VS. REAL TARGETS
	 	 Identify noise (scattered signals) caused by SOIL MINERALIZATION.

	 	 Look for prominent signals that extend over MORE THAN 1 IMPULSE.

3 COLOR INTERPRETATION
	 	 Look for STRONG SIGNALS (high contrast) regardless of their color.

	 	 RECONSIDER MULTIPLE INTERPRETATIONS of the different  
		  color-coded signals, as well as combinations of both.

4 SCAN VALUE STRENGTH
	 	 View the scan in SIDE VIEW OR FRONT VIEW to identify prominent 	
		  maximum amplitudes.

	 	 Check the SCAN VALUES AND THE VALUE RANGE between 	
		  the maximum, average, and minimum values of prominent impulses.

5 TROUBLESHOOTING
	 	 Identify SCATTERED SIGNALS – so-called noise.

	 	 Recognize STRIPED SCAN STRUCTURES and their causes.

	 	 Question RECURRING SIGNALS and determine their origin.

	 	 Prevent MISSING SCAN DATA due to transfer errors.

ADDITIONAL TIPS FOR EVALUATION

 ENSURE CORRECT SCAN FIELD DIMENSIONS

You can add and adjust the scan field dimensions at any time within your scan file in 
Visualizer 3D Studio.

The scan field size is – unlike what is common in graphic design – always defined as 
SCAN FIELD LENGTH FIRST, then width. This is based on the fact that the length 
of the first scan line is set first. The number of scan lines is determined afterwards, 
which defines the scan field width.

 UNDERSTAND THE LIMITATIONS OF THE TECHNOLOGY

Scans cannot precisely reveal what an object is – such as whether it is a vase, ring, 
statue, box, or sword. However, large objects such as aircraft or bunkers can become 
visible in their shape if the scan field is large enough.

 CONSIDER THE HALO EFFECT OF FERROUS OBJECTS

For ferromagnetic objects, the halo effect and corrosion traces in the surrounding soil 
must be considered, as they can distort the perceived size and shape of the target.

 CONSIDER THE PHYSICAL LIMITATIONS OF MAGNETIC FIELD MEASUREMENT

Furthermore, non-magnetic objects can only be detected through the surrounding 
structures. Magnetic Field Measurement, as the name implies, requires the presence of 
anomalies in the magnetic field. 

Anomalies are not caused by non-magnetic objects such as diamonds or gold 
themselves. However, they can be caused by human intervention, such as excavation. 
Depending on how recently the digging took place, this disturbance may still be visible 
in the scan results.

 LOOK FOR ASSOCIATED FINDS

Precious metals can be detected through associated finds, e.g. if it is located in a 
treasure chest with iron fittings, if ferrous artifacts are present nearby, or if it is made 
of an alloy that combines precious metals with ferromagnetic metals.

 ASSESS MAGNETIC PROPERTIES AND GEOLOGICAL CONTEXT

Gold deposits can still be detected with a high level of expertise and knowledge about 
the geological conditions that are typically associated with the desired valuable target 
structures. For more information, refer to our documents on Mineral Scan.

6	 SCAN ANALYSIS: IDENTIFYING AND ASSESSING TARGET SIGNALS
This chapter explains what the scan image actually shows and how to interpret signals correctly.  
UNDERSTANDING COLORS AND STRUCTURES – red, green, and blue – is essential for meaningful analysis.

No scan is ever identical to another; slight variations are always present.

With the previously acquired understanding of scan values and amplitudes, scan analysis becomes easier and more reliable. Real scan examples with clear explanations help 
illustrate how signals are formed and how they should be interpreted.

The Wireframe view improves 
the visibility of individual 
impulses (measuring points) 
and allows for 

•	 easier and more precise 
crosshairs placement,

•	 clearer contrast between 
the signals, and

•	 faster assessment of the 
spatial extent of signals.

In addition, test different views 
with High Resolution enabled 
and disabled.

Both these options – Wireframe 
and High Resolution – can be 
enabled in the Visualization 
panel under Scan Image, 
accessible via:

•	 Icon  in the right sidebar

•	 Main Menu > View > 
Sidebars > Visualization.
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When comparing an original scan (left) and its control scan (right), both performed on 
the same scan field of adequate size and from the same starting point: The prominent 
signals at the same positions are promising, regardless of the surrounding colors in 
the scan field. If a positive or negative pole of an object has been detected, the signal 
will usually occur at the same position and with the same polarity in repeated scans.

By adjusting the Threshold or changing the Color Scheme – see 5.3 Focus on 
Target Signals on page 24 – or by applying filters (so-called Modifiers) – see 6.5 
Troubleshooting on page 42 –, the color spectrum can be smoothed to make relevant 
signals easier to identify.

When comparing an original scan (left) and its control scan (right), both performed on 
the same scan field of adequate size and from the same starting point: The strong shift 
of the signal in terms of position and color is more likely an indication of false signals.

As already described, scan values are recorded and processed relative to each other 
– see 5.3.3 Color Interpretation on page 25. This means that a stronger signal can 
dominate the scan result and partially or completely mask previously detected weaker 
signals. In the example below, the result could therefore be caused by such a stronger 
signal influencing the relative scaling. 

It is also possible that a false signal was generated – for example by inadequate probe 
movements or by metallic items held too close to the sensors during the measurement.

6.1 COMPARE CONTROL SCANS
Control Scans are essential for verifying detected signals. By comparing multiple 
scans of the same area, it becomes easier to distinguish real targets from noise or 
soil-related effects. REAL TARGETS DO NOT MOVE, so their position should remain 
consistent across all Control Scans.

For an effective comparison, ARRANGE THE SCAN IMAGES NEXT TO EACH OTHER 
via Main Menu > Window > Arrange Side by Side. Viewing the scans simultaneously 
allows you to identify differences and similarities more easily (see example below).

If the area was scanned from a 90° angle, ROTATE THE SCAN IMAGE to improve 
comparability between the scans (see example below).

If the scan field is sufficiently large and the signals shift only slightly, this is acceptable 
and does not invalidate the result.

Minor variations in signal size and position within the scan field can occur if:

•	 the walking speed varied during the measurement,

•	 a different number of impulses was recorded, or

•	 the starting point was slightly offset.



34 / 54 35 / 54

If the scan image shows a large number of signals, this usually indicates so-called 
noise, appearing as scattered signals without any clear structure. In Side View, no 
prominent amplitudes are visible either. This is an indication that no meaningful 
target signal is present and that the observed effects are most likely caused by SOIL 
MINERALIZATION – see 6.5.1 Scattered Signals on page 42.

6.2 IDENTIFY REAL VS. FALSE TARGETS

A promising – or at least potentially relevant – signal is usually a COHERENT, CLOSED 
COLOR AREA – in RGB color scheme either red or blue –, often circular or oval in 
shape. The single signal shape can be clearly distinguished from the surrounding scan 
field and extends over multiple scan values (see image 1: red signal + blue signal).

In some cases, the signals are shaped or combined to a more complex and irregular 
structure of multiple signals. This is commonly referred to as 

•	 SIGNAL STRUCTURE: e.g. U-shaped, elongated, curved signal shapes 
(see blue signal in images 2 and 3), or 

•	 SIGNAL CLUSTER: signal shapes of the same color located close to each other 
(see orange signals in image 3).

A COMBINED SIGNAL STRUCTURE consists of two or more signals of various colors – 
usually red and blue (see image 2). 

By considering not only the shape, color combination, and spatial extent, but also its 
amplitude and repeatability in control scans, the signal structure can be described 
as a SIGNATURE. This term is interpretative, not purely descriptive. In most cases, a 
combined red-blue signature indicates a ferromagnetic object (see image 1).

For further interpretation, the next important step is to evaluate the signal structures – 
see 6.3 Interpret Colors and Structures on page 36.

What all of these shapes, clusters, structures, and signatures have in common is 
their CLEAR CONTRAST to the surrounding scan field, that is ideally represented 
as relatively neutral background. To better recognize and identify these contrasts, 
consider using the Wireframe view – see 6	 Scan Analysis: Identifying and Assessing 
Target Signals on page 30.

If a strong signal shape (red or blue) is visible in the scan image, but consists of only 
one single impulse, this indicates either 

•	 a very SMALL NEAR-SURFACE METAL OBJECT, such as a screw or nail, which 
should be removed from the scan field, or

•	 a FALSE SIGNAL, in which case applying the Signal Correction modifier can be 
helpful – see 6.5.5 False Signals on page 43.

In the example above, the original scan (see image 1) showed a green-orange 
background (neutral soil) with a prominent blue spot. On closer inspection using 
Wireframe view (see image 2), it becomes apparent that the strong blue signal consists 
of only a single scan value. After applying the Signal Correction modifier, the blue signal 
at this position disappears, while other signals become more prominent.

In either case, this does not indicate a meaningful signal. Proceed with a Control Scan, 
or, if desired, proceed with excavation at your own judgment.
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6.3 INTERPRET COLORS AND STRUCTURES
First, move away from the commonly held assumption that red indicates a treasure – 
sometimes it is even claimed to be gold – and that blue indicates a natural void – see 
5.3.3 Color Interpretation on page 25. Always keep in mind the physical limitations 
of the technology (gold and voids are non-magnetic) and toggle between the color 

schemes to gain a different perspective 
on the meaning of signal colors. 

Every scan image always contains red, 
green and blue signals. The maximum 
value is always displayed as red signal, 
the minimum value is shown in blue.

A COMBINED RED-BLUE SIGNAL 
STRUCTURE OF VARYING STRENGTHS  
can also be interpreted as a 
ferromagnetic target object. In this 
case, it may be positioned diagonally in 
the ground, where the stronger signal 
represents the upper end of the object.

Alternatively, this signal structure may 
indicate two target objects positioned 
vertically with their respective poles 
oriented upward. 

In this scenario, the stronger signal 
originates from the object with the 
stronger ferromagnetic pole or located at 
a lower depth (closer to the sensor).

A COMBINED RED-BLUE SIGNAL 
STRUCTURE OF EQUAL STRENGTH 

is usually interpreted as a target object 
containing ferromagnetic components 
and lying horizontally in the ground. In 
horizontal orientation, the positive and 
negative pole of the object are visible.

As shown in the single-signal example, 
the red-blue signal combination can also 
indicate two separate objects positioned 
vertically in the ground.

In this example, the following signals can be identified: 
a smaller, weaker orange signal, a larger orange-red 
signal, as well as an elongated diagonal blue signal 
with slightly stronger amplitudes at both ends. This 
structure may indicate: 
•	 a large rectangular object with multiple 
ferromagnetic components, 
•	 two horizontal ferromagnetic objects, or
•	 various diagonal and/or vertical objects.
Performing control scans with higher resolution can 
reveal additional details for more precise conclusions.

A verified SINGLE SIGNAL usually indicates one pole of a ferromagnetic object that is 
vertically oriented: either the negative pole that is represented by a blue signal (lowest 
values) or the positive pole by a red signal (highest values). Multiple such signals, red 
and blue mixed, can occur separetely within the same scan field (see image above).

For correct interpretation, the next important step is to evaluate the signal strength 
(amplitude) – see 6.4 Assess Scan Value Strength on page 38.

The different sizes and color intensities of the signals provide indications of the 
relative depth and position of the objects in relation to each other.

This example contains numerous red and blue signals 
with highly IRREGULAR DISTRIBUTION, lacking a 
coherent structure. As a result, it is very likely that this 
scan field does not contain a detectable target object. 
The observed signals are most likely caused by 
SOIL MINERALIZATION and/or small near-surface 
interference sources, such as nails, screws, or other 
small scrap metal.
Only a control scan allows verification of the signals 
through their repeatability.

If a signal corresponds to only one impulse, it is most 
likely a FALSE SIGNAL that can be reduced by applying 
the Modifier Signal Correction – see 6.5.5 False Signals 
on page 43. 
Signals that span only 1 impulse can also originate from 
very small near-surface objects such as a screw or nail, 
which can usually be removed from the scan field with 
minimal effort.
Only a control scan allows verification of the signals 
through their repeatability.
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6.4.3 EXAMPLES: EVALUATING SIGNALS BASED ON VISUALS AND VALUES6.4 ASSESS SCAN VALUE STRENGTH
6.4.1 VISUAL SIGNAL IDENTIFICATION
As already mentioned in 5.2.2 Further Views on page 23, Side View and Front View are 
particularly useful for identifying signal amplitudes visually based on the scan image. 
These views make it easier to recognize where the strongest amplitudes occur and 
how the values are distributed in the scan field.

If several signals 
are located close 
to each other, it is 
recommended to 
inspect the scan from 
all four directions. 
Viewing the scan from 
multiple angles helps 
to better distinguish 
individual signals 
and increases the 
reliability of the signal 
interpretation.

In this example, the 
combined red-blue 
signal structure can 
be distinguished very 
easily in Side View,  
but it is very difficult to 
identify in Front View.

Top View Side View (right)

Front View Side View (left)

6.4.2 SCAN VALUE RANGES AND AMPLITUDES
Use the Scan Information panel (via right sidebar) to access exact SCAN VALUES. 
Check the values at the most prominent signals and compare them to the surrounding 
background values. The most prominent signals correspond to the minimum and the 
maximum scan value, representing the strongest amplitudes in the scan.

Determine the ranges between

1.	  minimum and average neutral values,

2.	  maximum and average neutral values,

3.	  the average deviations compared to  
the highest amplitudes (∆) –  
see 6.4.4 Sufficient Signal Amplitudes on page 41.

The scan values must show sufficiently large deviations. 

1.	 Select the desired VIEWPORT  
or  in the main toolbar to display 
multiple perspectives simultaneously.

2.	 Switch between views to find the 
most suitable PERSPECTIVES for 
identifying signal amplitudes – via 
left sidebar or by using the following 
Keyboard Shortcuts:

F5  Perspective View

F6  Top View

F7  Side View (right)

F8  Front View

Ctrl  + F7  Side View (left)

Ctrl  + F8  Rear View

1

2

EXAMPLE 1: This scan shows a minimum scan value of −1,385.30 (image 1) and a maximum of 1,471.83 (image 2).

The neutral soil shows scan values at different positions (images 3 to 5) of −25.75, 202.25, and 61.72. These scan values differ remarkably from the minimum −1,385.30 and maximum 
1,471.83, resulting in a significant difference with an average magnitude of around 1,300. This range indicates a clearly distinguishable signature and thus a potential target object.

1 2

4 5

For further evaluation, the next important step is to determine the position and 
estimate the depth of the signal – see 5.5 Access Scan Information on page 28.

Scans with only few prominent signals are the easiest to interpret. In practice, scan 
images often appear more complex, as shown in the following examples:
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6.4.4 SUFFICIENT SIGNAL AMPLITUDES
After reviewing the examples, it becomes clear that, both the initial visual impression 
and the scan values are essential, as a purely visual interpretation can be misleading. 
The graphical representation may be distorted in a way that makes amplitudes 
appear stronger than the underlying scan values actually are – see Example 2 and the 
following corresponding graphical summary:

The scan values must show sufficiently large deviations. If amplitudes and deviations 
are too low in value, they usually do not indicate relevant targets.

EXAMPLE 2: In this scan image, 3 signal structures (blue) and 3 signal clusters (orange) can be identified when looking at the Top View at first glance.  
These signals are surrounded by neutral soil, represented in the typical green color. 

When looking for the minimum (image 2) and maximum scan values (image 3), the available views play an essential role: In Front View, both the blue minimum and the red maximum 
are easy to identify. In the Side Views, however, multiple blue and reddish peaks are visible, all of which may appear relevant at first glance.

During analysis of all views together with the scan values, it becomes apparent that the minimum value of 131,511 is located at the beginning of the third scan line, while the 
maximum value of 131,696 is positioned in the center of the scan field. Based on these facts, the distribution could initially suggest the presence of three separate ferromagnetic 
objects, buried horizontally with a slight inclination. However, comparing these values and their deviations, it becomes clear that the amplitudes are very low. 

The average difference between the signal amplitudes and the neutral values is only around 100, which appears very low given the overall high scan values of >130,000. Despite the 
visually appealing signal clusters and structures, it is therefore questionable whether real target objects are present. The signals may instead be caused by external interference, for 
example from metal fences located to the right of the scan field, which could explain the blue signal patterns. For a more reliable interpretation, control scans are required. 

EXAMPLE 3: This scan result 
shows many scattered signals in 
Top View (image 1). When viewing 
the scan from all four sides (image 
2), it becomes apparent that both 
blue and red signals are distributed 
across the entire scan field and 
exhibit similar amplitudes. 

A closer examination of the  
scan values ranging from  
a minimum of −78 to a  
maximum of 50 confirms that no 
relevant signals are present. This 
clearly indicates soil mineralization 
rather than a meaningful target.

1

Top View

Side View (left)

Front View

Side View (right)

2 3

131,696
131,511

⌀ 131,630

∆ ≈93

Side ViewFront View

Front View Side View

50

−78

⌀ -3

∆ ≈64

1,471.83
−1,385.30

⌀ 80

∆ ≈1,300

In order to identify relevant signals that indicate the presence of a potential target 
object, it is important to 

1.	 focus on ISOLATED LOCAL SIGNALS and its immediate surroundings, 

2.	 compare the signal structure to the OVERALL SCAN FIELD,  
including the neutral scan values as well as  
the total number of collected measuring values,

both visually and in terms of the scan values. In cases of uncertainty, performing 
control scans is always recommended.

In the summary of Example 3 (above), the 
blue and red values are distributed very 
evenly and show similar strong amplitudes 
throughout the entire scan field. No individual 
signal stands out clearly.

In contrast, Example 1 (right) shows a 
remarkable difference between the signal 
amplitudes and the neutral values, which 

confirms the presence of a relevant anomaly.
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6.5.4 VERTICALLY STRIPED

Vertically striped signal structures are usually caused 
by ROTATIONAL ERRORS. These occur when the scan 
direction is not consistently followed. Depending on the 
selected Scan Mode, the scan field must be traversed 
in specific ways. In both Parallel and Zigzag mode, the 
probe must always point in the same direction as in the 
first scan line. If this is not maintained, rotational errors 
can occur in the scan image (see left image).

Recommendations:

•	 Repeat the scan in Zigzag mode correctly.

•	 Repeat the scan in Parallel mode.

•	 Learn about correct scanning techniques in our 
manuals, 3D Ground Scan Guide, and tutorials.

•	 Apply the Rotational Correction modifier.

Correct the scan values retrospectively using the 
Modifier ROTATIONAL CORRECTION. You can find this 
filter via Right Sidebar > Modifiers: Click the  and 
select Rotational Correction – see Reference: Rotational 
Tests with OKM Rover C4 on page 52.

Please note: A correctly performed measurement is 
always preferable (see right image). Alternatively, use 
Parallel mode, which consistently produces clearer and 
more reliable scan results.

6.5.5 FALSE SIGNALS

False signals can appear as isolated spots (see left 
image) or as regularly recurring signals. These 
are most commonly caused by IMPROPER SCAN 
TECHNIQUE, such as insufficient distance between 
metallic objects and the sensors. 

In some cases, a strong single-impulse signal 
originates from a SMALL, NEAR-SURFACE METAL.

Recommendations:

•	 Clear the scan field of small metallic objects such 
as screws or nails on the surface.

•	 Repeat the scan with the maximum possible 
distance between the sensors and the Control 
Unit, smart device, clothing or footwear.

•	 Apply the Signal Correction modifier.

Remove false signals retrospectively using the Modifier 
SIGNAL CORRECTION (see right image). You can find 
this filter via Right Sidebar > Modifiers: Click  and 
select Signal Correction.

If the result shows only noise or no prominent signals, 
there is very likely nothing present at that 
location. In any case, we recommend performing 
control scans.

6.5 TROUBLESHOOTING
6.5.1 SCATTERED SIGNALS

Scattered signals – so-called NOISE – usually 
appear as a large number of red and/or blue signals 
distributed across the entire scan field without showing 
a recognizable or coherent structure. This is a typical 
indication of SOIL MINERALIZATION rather than real 
targets.

This structure is also recognizable in Side View or 
Front View, where similarly strong or weak amplitudes 
are distributed across the entire scan field and no 
prominent signal can be identified.

Recommendations:

•	 Repeat the scan using smaller scan line spacing 
to achieve higher resolution.

•	 If possible, dig near the surface and remove small 
scrap metal, then scan again.

•	 If no clear targets are detected in control scans, 
increase the size of your scan field or move the 
scan field and continue scanning in a different 
area – see Reference: OKM eXp 5500 Scan on Field 
near Medieval Castle on page 45.

6.5.2 MISSING SCAN DATA

The empty corner in the upper left indicates a  
DATA TRANSFER ERROR. Such scan images are 
extremely rare, as this issue only occurs with detectors 
requiring the number of impulses to be entered 
manually during data transfer.

In the example above, the preset number of impulses 
per scan line is 30, but the total number of impulses 
transfered is only 80 (see right image). 

These 80 impulses are automatically distributed across 
the three scan lines as 30, 30, 20 – leaving the final 
section of the third scan line empty (see left image).

As a result, the measuring values are shifted within the 
scan field, making a reliable analysis impossible.

Recommendations:

•	 Transfer the scan file again and enter the correct 
number of impulses per scan line.

•	 Repeat the measurement if the scan file is no 
longer available.

6.5.3 HORIZONTALLY STRIPED

Horizontally striped signal structures are usually 
caused by PROBE BOUNCING, meaning the probe was 
moved up and down while scanning (left image).

The scan result can usually not be corrected using 
modifiers. It is required to repeat the scan (right image).

Recommendation:

•	 Repeat the scan and make sure to walk smoothly 
and evenly, keeping the probe at a constant height 
throughout the scan – see 3.3 Maintain a Constant 
Probe Height on page 13.
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OKM DETECTORS

Scan 1	 4×4 m | 13×13 ft

Output: Scattered signal structure across 
the entire scan field, no distinct signal, 
multiple interference effects. 
Recommendation: Check Side View (see 
below): Blue and red signals do not show 
significant amplitudes. Eliminate obstacles 
and/or move the scan field.

Very unstable signal structure, shows 
linked red and isolated blue signals, looks 
streaky, no clear signal can be detected. 

Repeat the scan and move the scan field.

Scan 2	 4×4 m | 13×13 ft

Output: Signal at the edge. 
Recommendation: Move the scan field.

The scan field of Scan 1 was moved to 
the left. Some weak interference is still 
visible. A clear signal at the left edge – a 
combination of a red and a blue spot 
immediately next to each other – suggests a 
potential target object.

Scan 3	 4×4 m | 13×13 ft

Output: Clear signal in the center of the 
scan field. Side View (see below) shows two 
distinct amplitudes. 
Recommendation: Perform a Control Scan 
to verify the signal.

The scan field of Scan 2 was moved further 
toward the signal. Now the signal is 
perfectly centered in the scan field.

Scan 4 – Control Scan	 4×4 m | 13×13 ft

Output: Very similar signal in the same 
location as in the previous scan. Side View 
(see below) shows two distinct amplitudes. 
Recommendation: Determine the depth in 
V3DS and excavate the target object. 
Target Object: Iron tool, buried horizontally 
at a depth of approx. 16" (40 cm). 

Scan 3 was repeated on the same scan field 
in the same direction. The detected signal 
structure is very similar and in the same 
location.

7	 RELATED RESOURCES
For more detailed information and practical guidance, please refer to the available 
documentation and tutorials:

•	 Visualizer 3D Studio provides an integrated SOFTWARE DOCUMENTATION as well 
as online resources to support efficient data analysis. 
▸ www.okmdetectors.com/v3ds-documentation

•	 The 3D GROUND SCAN GUIDE and the MANUAL of your specific detector offer 
essential instructions on correct scanning technique and device handling. 
▸ www.okmdetectors.com/3d-ground-scan-guide 
▸ www.okmdetectors.com/manuals

•	 OKM WHITEPAPERS include case studies that contain real scan data from 
specific search projects, providing deeper insight into practical applications and 
scan interpretation. 
▸ www.okmdetectors.com/whitepapers

•	 VIDEO TUTORIALS, such as the Quick Scan Check playlist and dedicated videos 
on Control Scans, are available on our YOUTUBE CHANNEL and provide visual 
step-by-step examples. 
▸ www.youtube.com/okmdetectors

Further documentation and guides aimed at improving efficiency and scan 
interpretation are currently in development and will be made available in the future.

8	 SCAN ANALYSIS CASE STUDIES
In this section, we have compiled scans from customer inquiries, search projects,  
and reference projects. The following examples illustrate practical scan results of 
BOTH IDEAL AND CHALLENGING CASES, along with the steps required for a reliable 
scan analysis, which have been explained in this guide.

For better traceability, the following details are provided in each reference example:

•	 scan images: comprise a scan series from the same scan field – unless explicitly 
stated otherwise,

•	 scan series organization: include scan number, indication of whether it is a 
control scan, the detector used, and the scan field dimensions,

•	 Output: provides a brief description of what is immediately noticeable in the scan 
image,

•	 Recommendation: provides suggested steps to improve or verify the analysis,

•	 a more detailed explanation, and

•	 in the final scan image of each scan series, the excavated target object –  
if applicable.

Reference: OKM eXp 5500 Scan on Field near Medieval Castle

You performed scans that show particularly clear results or special characteristics, 
and you have excavated at the corresponding location? Help us confirm how well the 

scan analysis matches the actual result. We would be grateful to expand the following 
REFERENCE CATALOG with your contribution.

Join our TREASURE REWARD PROGRAM and send us  
your scan files along with details about your excavation!
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Reference: Customer Scan Series of a Scan Field

Scan 1/8   5×5 m | 16×16 ft

Output: Single orange and red signals. 
Recommendation: Increase the Threshold 
and perform further Control Scans. Expand 
the size of your scan field.

The scan image shows several medium and 
a few weaker but still detectable signals, 
resembling a structure of three horizontal 
lines. 
In V3DS, visibility can be improved by 
increasing the Anomaly Threshold (see 
image below). 
At least one Control Scan is required. 
Scan 1 with Increased Anomaly Threshold:

Scan 2/8 – Control Scan, rotated 180°	
5×5 m | 16×16 ft

Output: Similar signal structure at the 
same spots as in the previous scans. 
Recommendation: Expand the size of your 
scan field. Perform further Control Scans, 
compare the scans, determine the depth in 
V3DS, and excavate the target object(s).

The signal structures appear similar to 
those in the first scans: The separate 
signals resemble three horizontal lines. 
However, in this scan, they seem slightly 
distorted, likely due to varying walking 
speeds.

Scan 7/8 – Control Scan 
5×5 m | 16×16 ft

Output: Distorted signal structure, slight 
similarities at the same spots as in the 
previous scans. 
Recommendation: Compare with previous 
scans. When scanning, pay special attention 
to interference signals and the correct 
handling of the probe.

The stripe structure shows signs of 
interference signals, caused by e.g. 
smartphone or keys close to the sensors, 
or the probe was held incorrectly (changing 
height or rotation during scanning).

Scan 8/8 – Control Scan	 5×5 m | 16×16 ft

Output: Single orange signals at the same 
spots verify existence of anomalies . 
Recommendation: Compare with previous 
scans, determine the depth in V3DS, and 
excavate the target object(s). 
Target Object: Unknown.

The scan image shows several medium and 
a few weaker but still detectable signals. 
In V3DS, visibility can be improved by 
increasing the Anomaly Threshold (see 
image below).

Scan 8 with Increased Anomaly Threshold:

This test field measures approx. 5×5 m 
(16×16 ft ) and is classified with the soil type 
gravel. It is one of four test fields located on 
the OKM company premises in Altenburg, 
Germany. The test fields are regularly used 
for quality testing as well as tutorials.

The scans were performed under winter 
conditions (low temperatures, snow). These 
weather conditions do not affect magnetic 
field measurements.

The image was taken after all control 
scans had been completed. In the snow, 
the walking paths and the resulting scan 
grid across the scan field are clearly 
recognizable, which is very helpful for 
understanding the scan procedure.

Scan 1 – Original Scan 
5×4 m | 16×13 ft

Output: Typical signal structure for a 
ferromagnetic object, surrounded by 
striped scan structure. 
Recommendation: Perform Control Scans 
and ignore the stripes. 

This is a typical signal structure for a 
ferromagnetic object, surrounded by a 
slightly striped scan structure. These 
stripes originate from improper calibration, 
for example when calibration is performed 
too close to the concrete edge, which can 
cause interferences. Thus, the stripes 
can be disregarded; the decisive factor 
for further ground investigation is the 
prominent signal structure.

Scan 2 – Control Scan 
5×4 m | 16×13 ft

Output: Typical signal structure for a 
ferromagnetic object. 
Recommendation: Dig up the target object.

The Control Scan was repeated in the same 
manner as Scan 1 and shows the same 
signal structure – with slightly less striping. 
The anomaly is clearly visible and appears 
at the same location within the scan field.

Scan 3 – Control Scan, rotated 90° 
5×4 m | 16×13 ft

Output: Typical signal structure for a 
ferromagnetic object. 
Recommendation: Dig up the target object. 
Target Object: Iron plate, approx. 30×40 cm 
(12×16") in size, buried horizontally at a 
depth of approx. 30 cm (16").

The third scan was conducted on the same 
scan field, but rotated by 90 degrees.

The stripes are much more prominent 
but can still be disregarded. However, the 
striping clearly indicates the scan direction 
within the scan field.

The signal structure detected in the 
previous scans is clearly recognizable 
again, showing the same intensity and 
position within the scan field.
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Scan 1 | Fusion Light 
22x8 m | 72x26 ft

Output: Striped structure with several  
weak signals and a stronger signal at the 
upper edge of the scan field. 
Recommendation: Perform Control Scans 

to verify the potential target 
signals. Move the scan field 
to see the target signal at the 
upper edge more clearly.

Scan 2 | Rover C4 with Super Sensor 
22x8 m | 72x26 ft

Output: Combination of blue and red signal 
side by side, in the center and at the upper 
edge – same locations as in Scan 1. 
Recommendation: Perform Control Scans 
to verify the potential target signals. Move 
the scan field to determine the size of the 
potential target signal at the upper edge.

Scan 3 | eXp 5500 with Super Sensor 
22x8 m | 72x26 ft

Output: Combination of blue and red signal 
side by side, in the center and at the upper 
edge – very similar to the previous scans. 
Recommendation: Move the scan field to 
determine the size of the potential target 
signal at the upper edge.

Scan 4 | eXp 5500 with SuperSense System 
(5 sensor pairs side by side) 
22x8 m | 72x26 ft

Output: Combination of blue and red signal 
side by side, in the center and at the upper 
edge – very similar to the previous scans. 
Recommendation: Move the scan field to 
determine the size of the potential target 
signal at the upper edge.

Scan 5 | Fusion Light 
4x3 m | 13x10 ft

Output: The scan shows a clear signal 
structure in the center, with blue and red 
spots clearly distinguishable. Next to it, 
another very weak signal structure can be 
recognized. 
Recommendation: Perform Control Scans 
and increase the scan field dimensions for 
more surrounding scan values.

In the previous large-scale scans (1 to 4), a 
distinctive signal structure was detected at 
the upper edge of the scan field. The scan 
field for the current scan was adjusted 
accordingly in order to analyze this signal 
structure more precisely.

Scan 6 | eXp 5500 with Super Sensor 
8x6 m | 26x20 ft

Output: The scan shows a clear signal 
structure in the center with blue and red 
spots. The weaker signal structure next to 
it is more clearly visible than in Scan 5. 
Recommendation: Perform another Control 
Scan and excavate the target object.

Scan field 5 was expanded to achieve more 
precise results. The prominent signal 
structure appears at the same location as 
in the previous scans. The weaker adjacent 
signal is also slightly more visible.

Scan 7 | eXp 5500 with SuperSense 
System (5 sensor pairs side by side) 
8x6 m | 26x20 ft

Output: The scan shows a clear signal 
structure in the center with blue and red 
spots. Next to it, a weaker signal structure 
is visible. 
Recommendation:  
Excavate the target object.

The same scan was repeated using the 
SuperSense System (five sensor pairs 
operating simultaneously side by side). 
The signal structure – a red and blue spot 
– was detected at the same location within 
the scan field.

The detected reference object was not 
excavated immediately, but left in the 
ground for further test scans with the eXp 
7000 using the SuperSense System (seven 
sensor pairs simultaneously side by side).

Scan 8 | eXp 7000 with SuperSense  
System (7 sensor pairs side by side) 
8x5 m | 26x16.4 ft

Output: The scan shows a clear signal  
structure in the center. Next to it, the 
weaker signal structure is more clearly 
visible than in previous scans. 
Recommendation: Dig up the target object. 
Target Object: Iron bucket, rusted, filled 
with soil, buried horizontally at a depth of 
approx. 45 cm (18").  

This Control Scan was performed with the 
eXp 7000 using the SuperSense System. 
Due to a time delay of several weeks, the 
scan field is positioned slightly offset. 

The signal structure is clearly recognizable 
at the same location within the 
scan field, and the adjacent 
weak signal is now much more 
visible.

Reference: Scans with OKM Detectors at Halbes SchlossReference: Scans with OKM Detectors at Halbes Schloss48 / 54 49 / 54https://service.okmdetectors.com/r/g-sa-halbes-schloss https://service.okmdetectors.com/r/g-sa-halbes-schloss
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Scan 4 – Control Scan, rotated 90°,  
on modified field (incl. 2 marker flags) 
4×5 m | 13×16 ft (rotated for comparison)

Output: Distorted scan image with 
interference patterns, a prominent blue 
signal at marker flag 2, and a faint shadow-
like red-green structure. 
Recommendation: Repeat the scan with 
higher accuracy.

In this scan, due to the 90° rotation of the 
scan field, marker flag 2 was detected and 
masks the target signal of the pipe. Marker 
flag 2 is completely missed between the 
scan lines.

The interference pattern is caused by 
errors in the scanning technique: In scan 
lines 4 to 6, the starting points were 
not positioned consistently. As a result, 
scan values that should align are shifted 
forward and backward, creating visible 
discontinuities in the scan image.

This scan was performed in East-West 
direction, causing less accurate results.

Scan 3 – Control Scan, rotated 180°,  
on modified field (incl. 2 marker flags) 
5×4 m | 16×13 ft

Output: Clean scan image, a prominent blue 
signal at marker flag 1, and a faint shadow-
like red-green structure. 
Recommendation: If elongated objects are 
expected, always scan the area from two 
different angles.

This scan was performed in North-South 
direction, a different direction than Scan 4. 
As a result, marker flag 1 becomes visible 
due to the fact that the scan lines cross 
it, while marker flag 2, which is aligned 
parallel to the scan lines, is almost missed.

Reference: Multi-Target Detection Tests with OKM eXp 7000

This test field measures approx. 5×5 m  
(16×16  ft) and is classified with a sandy soil 
type. It is one of four test fields located on 
the OKM company premises in Altenburg, 
Germany. The test fields are regularly used 
for quality testing as well as tutorials.

The scans were performed under winter 
conditions (low temperatures, snow). These 
weather conditions do not affect magnetic 
field measurements.

The image was taken after all control 
scans had been completed. In the snow, 
the walking paths and the resulting scan 
grid across the scan field are clearly 
recognizable, which is very helpful for 
understanding the scan procedure.

Scan 1 – Original Scan 
5×4 m | 16×13 ft

Output: Significant large combined red-
blue signal structure in the lower area. 
Target: Steel-GRP gas pipeline,  
⌀ 19 cm | 7.7", depth: 80 cm | 32"

To demonstrate how multiple objects within 
a single scan field affect the scan result, a 
test scan series consisting of four scans in 
total was performed.

Scan 1 was performed on the original test 
field. In the final scan image, a large red–
blue signal signature is clearly visible. This 
signature corresponds to the steel pipe 
buried at a depth of 80 cm (32").

After Scan 1 was completed, the scan field 
was modified by adding two objects on the 
surface: marker flags with steel rods. One 
was positioned perpendicular to the scan 
direction (1), while the other was aligned 
parallel to the scan lines (2).

Scan 2 – Control Scan  
on modified field (incl. 2 marker flags) 
5×4 m | 16×13 ft

Output: A distinct red signal (with faint 
blue pole to its left) in the upper part, 
accompanied by a faint shadow-like 
structure in the lower area of the scan field.  
Recommendation: Review the scan image 
during the scan (ideally after each scan line) 
or afterward using the Replay function on 
the Control Unit, if available. 

The dominant red signal originating 
from the positive pole of marker flag 1 
overshadows the other two targets: Both 
the larger, stronger pipe located at greater 
depth and marker flag 2 are masked by this 
dominant signal of marker flag 1.

In addition to the dominant signal, a 
very faint blue signal is visible to its left, 
representing the opposite pole.

Scan 3 – Control Scan, rotated 180°,  
on modified field (incl. 2 marker flags) 
5×4 m | 16×13 ft

Output: A distinct blue signal (with faint 
red pole to its right) in the upper part, 
accompanied by a faint shadow-like 
structure in the lower area of the scan field.  
Recommendation: Review the scan image 
during the scan (ideally after each scan line) 
or afterward using the Replay function on 
the Control Unit, if available. 

The dominant blue signal originating from 
the negative pole of marker flag 1 also 
masks the other two targets: However, both 
the larger, deeper pipe and marker flag 2, 
which is located between the scan lines, are 
still more clearly visible in this scan.

This control scan was performed with 180° 
rotation relative to the other two scans. For 
easier analysis, the scan image was rotated 
back to its original orientation.
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Scan 1  
5×5 m | 16×16 ft

Output: Vertically striped structure. 
Recommendation: Repeat the scan using 
the correct scan direction, ensuring both 
walking direction and probe direction are 
consistent.

According to the Characteristics, the scan 
was performed in Scan Mode Parallel. After 
clarification with the user, the scan field 
was actually traversed in Zigzag, while 
the probe was held in a fixed orientation 
throughout the scan. This means that the 
probe was pointing in the wrong direction 
on every second scan line – see 6.5.4 
Vertically Striped on page 43.

Repeat the scan using the correct scanning 
technique.

Scan 2 – Control Scan in Parallel Mode 
5×5 m | 16×16 ft

Output: Calm scan field with strong signal 
at the edge (bottom left corner). 
Recommendation: Move the scan field to 
position the prominent signal in its center 
and determine the size of the target signal.

According to the Characteristics, the scan 
was performed in Scan Mode Parallel, this 
time correctly.

The scan field appears calm, with no 
prominent signals in the center.

A strong signal is present in the bottom 
left corner of the scan field. To obtain more 
detailed information about its size and 
structure, move the scan field so that this 
signal is positioned in its center.

Scan 3 – Control Scan in Zigzag Mode 
5×5 m | 16×16 ft

Output: Calm scan field with strong signal 
at the edge (bottom left corner). 
Recommendation: Move the scan field to 
position the prominent signal in its center 
and determine the size of the target signal.

According to the Characteristics, the scan 
was performed in Scan Mode Zigzag, this 
time correctly.

The scan field appears calm, with no 
significant signals in the center. A strong 
signal is present in the bottom left corner 
of the scan field, confirming the results of 
Scan 2. 

Move the scan field to get more detailed 
information about the size and structure of 
the prominent signal.

Scan 1 modified in V3DS 
5×5 m | 16×16 ft

Output: Strong signal at the edge (bottom 
left corner). 
Recommendation: Repeat the scan with 
correct scanning technique. Move the scan 
field to position the prominent signal in its 
center and determine the size of the target 
signal.

After evaluating the scan result of Scan 
1, control scans were performed. For 
comparison, the Rotational Correction 
modifier was applied to the measurement 
data of Scan 1 (see image above). The 
resulting scan image appears similar to the 
control scans.

However, perform scans correctly. This is 
always recommended to achieve clearer 
and more reliable results.

Reference: Rotational Tests with OKM Rover C452 / 54
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